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Marques commerciales 

Marques commerciales Exact Imaging : 

 ExactVu™ 

 Exact Imaging™ 

 FusionVu™ 

La visionneuse d’images médicales Weasis est utilisée en conformité avec la licence libre  

Eclipse Public License (EPL) (http://www.eclipse.org/legal/epl-v20.html). 

 

Informations sur la garantie 

Le système de micro-échographie ExactVu et ses accessoires, fournis et livrés neufs, dans leur 

emballage d’expédition d’origine à l’acheteur initial, bénéficient d’une garantie d’un an qui couvre 

les dommages matériels et les vices de fabrication, et/ou l’impossibilité de l’équipement de 

fonctionner conformément aux informations du Manuel de sécurité et d’utilisation du système de 

micro-échographie haute résolution ExactVu™.  

 

Informations sur la version 

Système :  Système de micro-échographie haute résolution ExactVu™ 

Guide d’utilisation de la visionneuse d’images médicales Weasis avec le système de  

micro-échographie ExactVu, révision 1.5 (FR), Traduction des instructions d'origine 

Le présent guide d’utilisation a été rédigé en référence à la version 3.0.4-EI.60 de Weasis. 

 

Déclaration de conformité DICOM 

La déclaration de conformité DICOM pour Weasis fournit des informations sur la conformité du logiciel 

Weasis à la norme DICOM et est disponible auprès d’Exact Imaging.  
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Chapitre 1 Introduction 

Le présent Guide d’utilisation de la visionneuse d’images médicales Weasis avec le système de  

micro-échographie ExactVu fournit des instructions pour utiliser correctement la visionneuse d’images 

médicales Weasis (« visionneuse Weasis ») avec le système ExactVu. La visionneuse Weasis doit être 

utilisée par des professionnels de santé qualifiés pour ajouter des repères aux images IRM du  

compte-rendu radiologique ou pour ajouter aux images IRM des annotations faites par un autre 

professionnel de santé qualifié (par ex. un radiologue) afin de permettre leur importation dans la 

fonctionnalité FusionVu™ ExactVu. 

 

Il est important d’utiliser le présent Guide d’utilisation de la visionneuse d’images médicales Weasis 

avec le système de micro-échographie ExactVu en association avec les autres instructions d’utilisation 

du système ExactVu, en particulier : 

Document 

Manuel de sécurité et d’utilisation du système de micro-échographie haute résolution ExactVu™ 

Guide d’utilisation de la visionneuse d’images médicales Weasis avec le système de micro-

échographie ExactVu (le présent document) 

Tableau 1 : Documentation Weasis 

Les numéros de référence Exact Imaging pour les configurations du système de micro-échographie 

ExactVu sont les suivants : 

 EV-SYS-220 : Système d’imagerie par micro-échographie ExactVu™ (220V) 

 EV-SYS-120 : Système d’imagerie par micro-échographie ExactVu™ (120V) 

 EV-SYS-100 : Système d’imagerie par micro-échographie ExactVu™ (100V) 

 

MISE EN GARDE 
EN-W1 

 

L’inobservance des consignes de sécurité et/ou l’utilisation du logiciel à des fins 

autres que celles décrites dans la documentation Weasis constituent un usage 

inadéquat. 

MISE EN GARDE 
EN-W6 

 

L’utilisation de cet équipement est réservée à des opérateurs qualifiés. 

Les opérateurs doivent s’être parfaitement familiarisés avec le fonctionnement 

de cet équipement en toute sécurité et être bien informés sur les procédures 

d’échographie urologiques afin de réduire la gêne occasionnée et d’éviter toute 

blessure sur le patient. 

Lire toute la documentation fournie avec cet équipement. 

MISE EN GARDE 
EN-W2 

 

Aucune modification de ce logiciel n’est autorisée, car elle risquerait d’en 

compromettre le fonctionnement sûr. 
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Chapitre 2 Informations générales 

1 Sécurité du produit 

1.1 Généralités 

MISE EN GARDE 
EN-W85 

 

Si la visionneuse Weasis fonctionne mal, si elle ne répond pas, si l’image est 

fortement déformée ou dégradée ou en cas de suspicion d’un dysfonctionnement 

quelconque du logiciel, contacter l’assistance technique en utilisant les 

coordonnées figurant à l’Annexe A. 

1.2 Prise en charge pour le DICOM 

Le système ExactVu lit les données des études IRM au format DICOMDIR, dans lequel l’étude est 

annotée à l’aide d’un poste de travail DICOM qui prend en charge la fonctionnalité DICOM GSPS 

(Grayscale Softcopy Presentation State) pour l’annotation des IRM. 

 

La déclaration de conformité DICOM pour Weasis fournit des informations sur la conformité du logiciel 

Weasis à la norme DICOM.  

2 Précautions générales 

2.1 Système 

AVERTISSEMENT 
EN-C53 

 

Exact Imaging recommande aux établissements de prendre les mesures 

nécessaires pour protéger les postes de travail qui sont utilisés pour réaliser les 

tâches de la visionneuse Weasis contre les logiciels malveillants, les accès  

à distance non autorisés et toute autre menace pour la cybersécurité. 

AVERTISSEMENT 
EN-C54 

 

Exact Imaging recommande aux établissements de prendre les mesures 

nécessaires pour protéger les données des patients lorsque des périphériques  

de stockage externes (par ex. clés USB ou disques durs) sont utilisés. 
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Chapitre 3 Installation de la visionneuse DICOM pour FusionVu 

(Weasis) 

Cette section fournit des instructions pour télécharger et installer la visionneuse d’images médicales 

Weasis sur un poste de travail autre que le système ExactVu. 

 

L’installation se fait en deux étapes : 

 Téléchargement et installation de l’environnement d’exécution Java 64 bits 1.

 Téléchargement et installation de la visionneuse Weasis 2.

Conditions requises : 

 Pour installer la visionneuse Weasis, un ordinateur exécutant Windows 7 ou un système 

d’exploitation 64 bits plus récent est requis. 

Téléchargement et installation de l’environnement d’exécution Java 64 bits 

 Dans le navigateur web, aller sur https://java.com/en/download/manual.jsp. 1.

 Sélectionner le téléchargement intitulé Windows Offline (64-bit).  2.

 Ouvrir le fichier .exe et suivre les instructions affichées à l’écran pour terminer l’installation. 3.

Téléchargement et installation de la visionneuse Weasis 

 Aller sur la page des téléchargements sur https://www.exactimaging.com/downloads  1.

 Remplir le formulaire en ligne pour activer le lien permettant de télécharger la visionneuse 2.

DICOM pour FusionVu (Weasis). Cliquer sur le lien pour enregistrer le programme d’installation 

dans le dossier de téléchargement choisi. 

 Cliquer deux fois sur le fichier weasis.msi et suivre les instructions. 3.

 Utiliser le raccourci Weasis dans le menu de démarrage de Windows pour lancer la visionneuse 4.

Weasis.  

REMARQUE 
EN-N173 

 

Selon la version du logiciel antivirus installée sur le poste de travail, il pourra 

s’avérer nécessaire d’ajuster les paramètres de l’antivirus de façon à permettre 

l’installation à la fois de la visionneuse Weasis et de l’environnement d’exécution 

Java. 

Consulter votre administrateur système pour obtenir de l’aide au besoin. 

https://www.exactimaging.com/downloads
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Chapitre 4 Utilisation de la visionneuse Weasis avec ExactVu 

Pour annoter des images IRM à utiliser avec FusionVu, le logiciel Weasis est installé sur un poste de 

travail distinct du système ExactVu. 

 

Les images IRM sont récupérées à partir soit d’un lecteur externe (comme par exemple, un 

périphérique de stockage USB ou un DVD), soit d’un système PACS connecté au poste de travail de la 

visionneuse Weasis. 

 

Une fois les images IRM récupérées, la visionneuse Weasis est utilisée pour les annoter afin de pouvoir 

les utiliser avec FusionVu. 

1 Récupérer des images IRM à partir d’un lecteur externe 

Pour récupérer des images IRM à partir d’un lecteur 

externe : 

 Ouvrir le logiciel Weasis. 1.

 Cliquer sur l’icône Import (Importer) (en haut à 2.

gauche de l’écran) pour importer une étude.  

 Sinon, dans le menu, sélectionner 

File > Open > DICOM (Fichier > 

Ouvrir > DICOM). 

 Dans la boîte de dialogue Import DICOM 3.

(Importer DICOM), sélectionner le bouton pour 

faire défiler les études. 

 Dans la boîte de dialogue Open (Ouvrir), 4.

accéder au lecteur externe et sélectionner 

l’étude IRM. Cliquer sur OK. 

 Sélectionner Import and Close (Importer et 5.

fermer). Les images IRM se chargent. 

 Passer à la section 4 en page 10. 6.

 

 

 

 

2 Configurer la visionneuse Weasis sur le PACS 

Veuillez noter que cette configuration n’est effectuée qu’une seule fois. 

 Ouvrir le logiciel Weasis. 1.

 Dans le menu, sélectionner File > Preferences > DICOM node list (Fichier > Préférence >  2.

Liste de nœuds DICOM).  
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 Configurer un poste de travail local : 3.

 Sous DICOM calling Node (Nœud d’appel DICOM), sélectionner Add new 

(Ajouter nouveau). 

 Taper une description du poste de 

travail dans le champ Description 

(Description).  

 Taper le titre de l’entité d’application 

dans AE title (Titre de l’entité 

d’application), le nom d’hôte dans 

Hostname (Nom d’hôte) et le port dans 

Port (Port) pour le poste de travail. 

 Sélectionner Both (Les deux) dans le 

menu déroulant Usage type (Type 

d’utilisation). 

 Sélectionner OK. Dans l’invite de 

confirmation, sélectionner  

Close (Fermer). 
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 Configurer une connexion au système PACS : 4.

 Sous DICOM Node (Nœud DICOM), 

sélectionner Add new (Ajouter 

nouveau). 

 Taper le titre de l’entité d’application 

dans AE title (Titre de l’entité 

d’application), le nom d’hôte dans 

Hostname (Nom d’hôte) et le port 

dans Port (Port) pour le serveur PACS.  

 Sélectionner Both (Les deux) dans le 

menu déroulant Usage type (Type 

d’utilisation) (pour correspondre au 

type d’utilisation sélectionné sous 

DICOM calling Node [Nœud d’appel 

DICOM]). 

 Sélectionner OK. Dans l’invite de 

confirmation, sélectionner  

Close (Fermer). 

 

3 Récupérer des images IRM à partir d’un système PACS connecté 

 Dans le menu, sélectionner File > Open > 

DICOM (Fichier > Ouvrir > DICOM). 

 Sélectionner DICOM Query/Retrieve 

(DICOM Rechercher/Récupérer). 

 Rechercher l’étude de patient et  

la sélectionner. 

 Dans le menu, sélectionner Open > Import 

and Close (Ouvrir > Importer et fermer).  

 Passer à la section 4 en page 10. 
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4 Annoter des images IRM récupérées 

Après avoir sélectionné et importé les images d’une étude IRM à partir soit d’un lecteur externe, soit 

d’un serveur PACS connecté (comme décrit à la section 1 et à la section 2 respectivement), et avoir 

récupéré les images d’une étude IRM sélectionnée, annoter les images à utiliser avec FusionVu. 

 

Pour annoter des images à l’aide de la visionneuse Weasis : 

 Dans le menu contextuel Layout (Disposition), sélectionner 1.

1x2 Views (1x2 vues). 

 Sélectionner les plans sagittal et axial. 2.

 N’importe quelle séquence peut être utilisée 

(par ex. T1, T2 ou DWI). 

 S’assurer que les séquences sont appariées.  

 
 

 

 Avec la série importée affichée au format 1x2 Views  3.

(1x2 vues), sélectionner Line (Trait) dans les outils de mesure. 

 Dessiner un trait parallèle à la longueur de la prostate sur la 4.

paroi interne du rectum (série sagittale). S’assurer que le trait : 

 est compris entre 20 mm et 90 mm de long 

 est environ 25 % plus long que la longueur de  

la prostate 

 

 Sélectionner Ellipse (Ellispe) dans les outils de mesure. 5.

 Dessiner un cercle autour de chaque zone suspecte. 6.

 

5 Exporter les images IRM annotées 

 Pour exporter, cliquer sur l’icône Export (Exporter) (en haut à gauche de 1.

l’écran) pour exporter une étude. 

 Sinon, dans le menu, sélectionner File > Export > DICOM 

(Fichier > Exporter > DICOM).  

 Sélectionner la série d’origine ainsi que la nouvelle série (c.-à-d. la série 2.

annotée). 
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 Cliquer sur le bouton Export and Close (Exporter et fermer). 3.  

 Aller jusqu’à l’emplacement du lecteur de destination où la série sera exportée. 4.

 Créer un nouveau dossier.  5.

 Taper le nom du dossier 

en utilisant le nom du 

patient, plus le mot 

« annoté » (ou un mot 

similaire). 

 Cliquer sur New Dir 

(Nouveau répertoire), 

puis sur OK. 

 Un indicateur de 

progression s’affiche en 

bas à gauche de 

l’écran pendant 

l’exportation de l’étude. 

 

REMARQUE 
EN-N172 

 

Exact Imaging recommande d’enregistrer les études du poste de travail de la 

visionneuse Weasis sur un PACS ou sur un périphérique de stockage externe. 

6 Changer la taille de police par défaut de la visionneuse Weasis 

 Commencer par localiser le répertoire d’installation de la visionneuse Weasis, là où se trouve la 1.

visionneuse Weasis.  

 Aller jusqu’au sous-répertoire Weasis->conf. 2.

 Modifier les « config.properties » (propriétés de configuration) à l’aide de Microsoft WordPad 3.

(ou d’un éditeur de texte similaire qui prend en charge les interlignes Unix). (L’application 

Notepad ne prend pas très bien en charge les fins de ligne et n’est pas recommandée.)  

Pour ouvrir config.properties (propriétés de configuration) à l’aide de WordPad : 

 Dans Windows Explorer, cliquer avec le bouton droit de la souris sur 

config.properties (propriétés de configuration). 

 Sélectionner Open With (Ouvrir avec). 

 Sélectionner WordPad lorsqu’une liste des applications est affichée. Voir la Figure 1. 

1) Taper un 

nouveau nom 

de dossier 

2) Cliquer sur New Dir 

(nouveau répertoire) pour 

créer un nouveau dossier 
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Figure 1 : Ouvrir config.properties à l’aide de WordPad 

 Repérer la ligne « weasis.defaultfontsize=16 » (taille de police par défaut weasis=16). 4.

 Remplacer la valeur par défaut 16 par la taille de police souhaitée. La Figure 2 montre le 5.

remplacement de la taille de police par défaut de 16 par 20. 

 
Figure 2 : Exemple de remplacement de la taille de police de la visionneuse Weasis par défaut de 16 par 20 

 Enregistrer le fichier et redémarrer la visionneuse Weasis pour utiliser la nouvelle taille de police. 6.

7 Modifier la taille des miniatures 

 Une fois la visionneuse Weasis ouverte, cliquer sur le bouton « More Options » (Plus d’options) 1.

(gauche de l’écran au-dessus des miniatures). 

 Modifier la taille des miniatures selon votre préférence. Garde aux longs noms de fichiers qui 2.

peuvent ne pas être complètement affichés, selon la taille sélectionnée. 
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Si une assistance s’avère nécessaire, contacter l’assistance technique en utilisant les coordonnées 

figurant à l’Annexe A. 

 



Guide d'utilisation de la visionneuse d'images médicales Weasis avec le  
système de Micro-Échographie ExactVu Révision 1.5 

Exact Imaging  Page 14 sur 14 

Annexe A Coordonnées 

Pour l’assistance technique 

Région Numéro de téléphone Adresse électronique 

Toutes les régions, sauf l’Amérique du Nord - 

contacter EDAP TMS 

+33(0)472 153 150 ccc@edap-tms.com 

Amérique du Nord (US, CA, MX) - contacter 

EDAP TMS 

+1 (512) 852-9685 service@edap-usa.com 

 

Pour commander des consommables et d’autres accessoires et pièces 

Région Numéro de téléphone Adresse électronique 

France (FR), Belgique (BE) - contacter EDAP TMS +33(0)472 153 150 order@edap-tms.com 

Allemagne (DE), Autriche (AT), Suisse (CH) - 

contacter EDAP TMS GmbH 

+49 461 80 72 590 order@edap-tms.de 

Amérique du Nord (US, CA, MX) - contacter 

EDAP TMS 

+1 (512) 832-7956 order@edap-usa.com 

Toutes les autres régions - contacter EDAP TMS +33(0)472 153 150 order@edap-tms.com 
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